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Initial Documentation Notes:

Throughout this text, unless clearly indicated to the contrary, the term “CertPay” refers to the
iBrain, Inc. Application.

General Requirements:

Pentium 1 ghz or faster. A faster processor may be required by Peachtree.
512 MB of RAM minimum — more may be required by your accounting package.
Hard disk with 60 MB of disk space for installation. We recommend at least 500 MB
of free space to be available on the Hard Disk at all times.
A graphics card set to an 800x600 screen resolution. While CertPay will work with
lower screen resolutions, you will have to scroll to see all of some windows.
One of the following versions of Microsoft Windows:

Windows 2000 with Service Pack 4 or greater installed

Windows XP with Service Pack 2 or greater installed (32 or 64-bit)

Windows Vista (32 or 64-bit)

Windows 7 (32 or 64-bit)
Microsoft .NET Framework v2 must be installed.
Microsoft SQL Server 2005 must be installed if it is not present on the system. This
is provided on the CD.

Windows Terminal Services.

Windows 95, 98, 98SE, Windows NT 4, and ME are NOT supported.
This product will not operate in a Windows Terminal Server Environment using

Accounting Package Requirements (Please Read Carefully!!)

One of the following releases of Peachtree:

Peachtree Pro Accounting 2011/2010/2009

Peachtree Complete Accounting 2011/2010/2009

Peachtree Premium Accounting 2011/2010/2009

Peachtree Premium Accounting for Manufacturing 2011/2010/2009
Peachtree Premium Accounting for Distribution 2011/2010/2009
Peachtree Premium Accounting for Construction 2011/2010/2009
Peachtree Premium Accounting for Non-Profit 2011/2010/2009
Peachtree Quantum 2011/2010/2009

DO NOT attempt to enter or change company data while WizMag is retrieving data.

You must know the name of the folder in which Peachtree or QuickBooks has stored
your data and where that folder is (the path) on your computer’s hard drive.
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Updating CertPay

If you are updating an older copy of CertPay, DO NOT install the program in the
same directory as the old copy of CertPay. The program will not update any
existing program or data files in the installation directory. The default directory
for this version is different from the default directory for earlier versions. It is
not required that you ultimately uninstall the earlier version but you may wish
to do so to recover the disk space.

Installing CertPay

wn

A user who has an Administrator account must install this program.

Before installing CertPay, restart your computer and make sure that all other
programs are closed. This means closing Peachtree, as well as toolbars such as
those from Microsoft Office® or Lotus SmartSuite®.

Insert the CertPay disc into your CD-ROM drive. If the Install Wizard window does not

automatically appear:

e Click on Start, then on Run.

o Type in X\Apps\SETUP where the “X” represents your CD-ROM drive letter and
click OK.

Click on Install “Wizard” (3rd Option) from the list of items to start the installation.

If you do not have the .NET Framework v2 installed, it will be installed now.

e If you areinstalling the CertPay program downloaded from our web site, it will
download the .NET Framework and install it if it is not installed. An internet
connection is required to download the .NET Framework installation files. The
installation program is approximately 23MB and takes a few minutes to
download on a broadband (cable, DSL) connection. On a dial-up connection, it
will take at least 1 hour to download the .NET Framework installation files.
After the .NET Framework install is completed, it will prompt to restart the
computer.

Follow the prompts until you get to the End-User License Agreement.

Read the End-User License Agreement. If you agree to it, select | accept the terms of

the License Agreement and click Next to continue to the next step.

Select which accounting package will be used with this software, QuickBooks or

Peachtree. After you have made a selection, click Next to continue to the next step.

On the Ready to Install the Program step, examine the current installation settings. If

they are correct, click Install to begin the program installation.

Once the program installation is complete, click Finish.
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Installing SQL Server Express 2005

In order for CertPay to be able to open its database SQL Server Express 2005 must be
installed. To do so you can click Install SQL Server Express 2005 from the Install
Wizard menu or download and run the installer from the following locations:

Microsoft's web site:
http://www.microsoft.com/downloads/details.aspx?Family|D=85e0c3ce-3fal-453a-8ce9-
af6ca20946c3&DisplayLang=en

IBrain, Inc’s web site: http://www.ibraininc.com/downloads/misc/SSCERuntime-ENU.msi

Administrative rights are required in order to install the program.

Disabling User Access Control (Windows Vista/Windows 7 Only)

User Access Control (UAC) was added to Windows Vista and Windows 7 to decrease the
chance of malware or viruses infecting your computer. Unfortunately Microsoft SQL
Server 2005 Compact Edition requires UAC to be disabled in order to install properly.
The UAC Settings can be changed back when the installation is complete.

To disable UAC:
1. Click the Start button and select Control Panel.
2. Under Vista:
e Click User Accounts and Family Safety then User Accounts (standard
view) or User Accounts (Classic View).
e Click Turn User Access Control on or off.
e Click OK. You will be prompted to restart the system.

[E=3 EoH X

b_

@uvl}!‘ <« User Accounts » Turn User Account Contral On or Off - | +3 | | Search

File Edit ‘“iew Tools Help

Turn on User Account Control (UAC) to make your computer more secure

User Account Centrol (UAC) can help prevent unautherized changes to your computer, We recommend that
you leave UAC turned on to help protect your computer,

[#] Use User Account Control (UAC) to help protect your computer

OK | Cancel

Figure 1: User Access Control (Windows Vista)

3. Under Windows 7:
e Click User Accounts, then User Accounts again.
e Click Change User Account Control settings.
e Onthe User Account Control settings, slide the bar all the way from Default
to Never Notify
e Click OK. You will be prompted to restart the system.
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'&' User Account Contrel Settings E@

Choose when to be notified about changes to your computer

User Account Contrel helps prevent petentially harmful pregrams from making changes to your computer.
Tell me more about Uzer Account Control setfingd

Always notify

Default - Notify me only when programs try to make
changes to my computer

*  Don't notify me when I make changes to Windows
-E=- settings

@ Recommended if you use familiar programs and visit
- — familiar websites,

Mever notify

Figure 2: User Access Control Window (Windows 7)

Installing AccuWage and Adobe Acrobat Reader

AccuWage examines the structure of your report file to determine if there are structural
errors. It is recommended that you install this. Just follow the prompts on the screen after
the CertPay program installation. If you do not have the Visual Basic 6 runtime file
installed on your computer, the AccuWage installation program will install it and prompt to
restart the computer to finish the installation.

Documentation for CertPay is installed with the program. To view these files, you must
have Adobe Acrobat Reader installed.

To install Adobe Acrobat Reader, click on the Install Acrobat Reader item from the
Install Wizard window and follow the prompts.

Uninstalling CertPay:

DO NOT UNINSTALL CertPay unless an iBrain, Inc. technical support engineer
H instructs you to do so.
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Getting Started

Before installing and registering CertPay, we recommend that you copy your company
data to a separate location and name the company file or folder something you will
remember, like PR2009. In CertPay, you should use the copy of the company instead of
the original. The reason for this is threefold:

1.

2.

It copies your company to another directory, so any changes made to the copy don't
affect your original.

It allows other users to access the real company while you are retrieving data from
your accounting package. When CertPay is retrieving information, it is recommended
that no one else use that company.

According to the EFW2 (Social Security Administration) specifications, you have to
be able to reproduce a report for up to 4 years. CertPay can only retrieve data for the
2009 payroll year. By making a copy of the company, you are assured that you will
have the original data to reproduce the report.

To make a copy of your Peachtree company:
Determine your company directory name.

1.
2.

3.
4,

© N

13.

14.

15.

Open your company in Peachtree.

From the Help main screen menu, select Customer Support and Service and File
Statistics.

The company directory name will be in the title bar of the File Statistics Window.
Open Windows Explorer by pressing the Windows logo key on the keyboard and
the letter E.

Go to the drive and directory where your company data is stored. As an example, if
your DATAPATH is ‘C:\PEACHW’, then you would click Drive C, then the PEACHW
directory.

Select the Peachtree company folder specified in Step 1.

From the Edit pull-down menu, select Copy.

Navigate to the drive location where you would like to copy the company folder.
From the Edit menu, select Paste. If you copied the folder to the DATAPATH folder,
this will place a folder called Copy of XXXX, where the XXXX is the name of your
original company folder.

. Select the copy of the folder.
11.
12.

Click on the File menu, then on Rename.

Give the folder a meaningful name that is 8 characters or less without spaces and
press enter. Companies running CertPay with more than one Peachtree company
may want to use a folder name similar to PRO8xxxx, where xxxx is a four letter
Company ID.

Open the copy of the company in Peachtree. If you copied the file outside of the
DATAPATH, you will have to specify the location of the company folder before the
company name can be selected.

Note that there will be two companies with the same or similar names: the original
and the copy. To make sure that the company you open is the copy, follow step 1. If
it is the original company, open the other instance of the company.

Once you are certain that the open company is the copy that was made eatrlier,
change the company name by clicking the Maintain main screen menu and selecting
Company Information. Give it a meaningful name, like W-2 Payroll 2009. When
you select the company in CertPay, you can change the company name to the actual
name of the company.

To make a copy of your QuickBooks company:

1.

Determine your company file name. This is done by pressing the Control (Ctrl) and 1
keys. The Product Information window will appear with information related to your
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company. The File Information pane contains the location of the currently open
QuickBooks company (Figure 1). Write this location down.

— File Information

Location L\ QuickBooks Datal2005Conkract\PRO4SAMP . gb
]
Wersions Used on File
File Size 11837 K W7.00 R1 07/12/2000 ﬂ
Mode Size 1024 10,00 R1 03112002
Total Transactions 2454 R 03/11/2002

10.00 R2 03122002

Tokal T_argets 16057 10,00 A3 04 /032002
Tatal Links 2441 10.00 R4 0&/07/2002 =
Dictionary Entries 0

Figure 3: File Information Pane from the Product Information Window

N

Open Windows Explorer. It is located under Start, Programs, Accessories, and

Windows Explorer.

Go to the drive and directory listed in Step 1.

Select the QuickBooks company file specified in Step 1.

Click on the Edit menu, then on Copy.

Select where you would like to copy the company file.

Click on the Edit menu, then on Paste. If you copied the file to the same location as

the original company file, , this will place a file called ‘Copy of XXXX’, where the

‘XXXX' is the name of your original company file. Otherwise you will have a folder the

same name as your original company file.

8. Select the copy of the file.

9. Click on the File menu, then on Rename.

10. Give the company file a meaningful name and press enter. Companies running
CerdPay with more than one QuickBooks company may want to use a file name
similar to ‘PRO9xxxx’, where ‘xxxx’ is a four letter Company ID.

11. Open the copy of the company in QuickBooks.

12. Once you are certain that the open company is the copy that was made earlier,

change the company name by clicking on Company, then on Company

Information. Give it a meaningful name, like W-2 Payroll 2009. When you select the

company in CertlPay, you can change the company name to the actual name of

the company.

Nogkw

Registering CertPay

To start your program, double-click on its icon that was installed on your desktop by the
installation program, or select the program from your Start menu.

Product Registration

The first step in the product registration process is to enter product registration
information in the window shown in Figure 4. The following fields are required on the
registration form:

1. Company Name

2. Address 1

3. City, State, Zip Code
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Once you have entered and double-checked all required information, click OK to
continue.

Please enter the registration data to personalize this
application. This information will be used when registering the
application.

Company Name: |

Address Line 1:

Address Line 2:
City. State. dip:
Country:

Figure 4: Product Registration Information Window

Page 7
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Adding a Company

If a company has not yet been selected, you will see the Open Company Window
shown in Figure 5 below. The first time you run CertPay, there will be no companies in
the list. On the right side of the window, the total number of companies and the number

of companies that can be added are displayed.

|: |C::m|:|ar1]-I SID | [ Ok J

Selection Limit
1

Companies Left

Figure 5: Open Company Window

To add a QuickBooks company:
1. From the Open Company Window, click the Add a Company button. The Select

Company window as shown in Figure 6 will appear.

Quickbooks Company File:

Figure 6: Select Company Window (QuickBooks)

2. From the Company Information Window, click on the Browse button.
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| PerfLogs 1/20/2008 11:03 PM  File Folder
Folders A [ | 4

File name: - ’decbooks Files {*.QBW) v]

F Cpen |'! [ Cancel ]

Figure 7: QuickBooks Company Selection

3. Adialog box will appear for you to select the copy of your QuickBooks company file.
(Figure 7). Use the Look In drop-down to select the drive and folder that you had
written down when making a copy of your QuickBooks company. Select the copy of
your company file and click on Open to return to the Select Company Window.

4. The Select Company window will now contain the path to the QuickBooks company
file. Make sure that the company is open in QuickBooks in single-user mode and that
a user with Administrative rights is logged into the company and click OK. CertPay
will retrieve the company information and display it on the Verify Company window
(Figure 8).

Company Information Yerification

Waming: The information entered on this page wil be used as
the reporting and registration address. Entering incormrect
company information will require obtaining a registration
modification for which a fee will be charged.

Company 1D: i.brishish
Company Name:
Address Line 1:

Brian's Pole Shack|
123 Amywhere Ln

Address Line 2:

City. State Ap: Raleigh NC 12234

Courtry: 1SA FEIN: 121221133
SEIN: SUIN:

Figure 8: Verify Company Information
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The information on this window is used as your company information when
generating report files. Please make sure that this information is correct before
selecting OK to add the company to the list of new companies.

When entering the company information, make sure that the company name
matches the name for the FEIN.

5. Click OK to continue. You will be prompted to confirm the information from the Verify
Company window. If the information is correct, click Yes to continue. If information
needs to be changed, click No to return to the Verify Company Information window.

6. If the company information was accepted, the company that you added will then
appear in the list in the Open Company Window, and can now be opened.

To add a Peachtree Company:

1. From the Open Company Window, click the Add a Company button. The Select
Company window as shown in Figure 9 will appear.

.Open tompan)r:

|

|' | Company SID

Selection Limit
1

Companies Left

1

Figure 9: Select Company Window (Peachtree)

2. From the Company Information Window, click the Browse button. The Browse
For Folder window will appear.

3. Onthe Browse For Folder window, locate the DATAPATH folder that is one
directory level above your company folder (Figure 10) and click OK.

Page 10



Revision Combo3

Browse For Fi:-I_d;r 2

Select Peachtree Company Path

4. Microsoft. NET
. Microsoft SQL Server
. Microsoft S0L Server Compact Editior
b MSBuild
; NOS
, Pervasive Software
. PQA2009
4y Company

Figure 10: Browse For Folder

4. The Peachtree Company Selection window (Figure 11) will appear and display a
list of companies in the selected folder. If the company to be selected is not in the
list, click Cancel and repeat Step 3. Select your company from the list, verify that the
company folder shown under the list of companies is correct and click OK to return to
the Company Information Window.

r_Comparr:,' Data Path:
“\Program Files &86)\PQAZ00MCompany™) Browse

Companies:

Brian's Pole Shack m

Compary Folder:
brighish

Figure 11: Company Selection Window (Peachtree)

5. After OK is clicked on the Select Company window, the company information for the
selected company will appear on the Verify Company window (Figure 8).

6. Click OK to continue. You will be prompted to confirm the information from the
Verify Company window. If the information is correct, click Yes to continue. If
information needs to be changed, click No to return to the Verify Company
Information window.

7. If the company information was accepted, the company that you added will then
appear in the list in the Open Company Window, and can now be opened.
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The company information for the selected company will be displayed in the Company

Information Window (Figure 6). If any of the information needs to be edited, go to the
appropriate text box and edit the data.

If you click Cancel on the Open Company Window, you will only be able to access the
help files, open a company, or exit the program.
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Product Licensing

iBrain, Inc. has set this application to run as a 15-day trial. It will do anything that a
registered CertPay would do, but will display a trial notification window when starting the
program. At any time prior to the expiration of the 15-day trial period, the program can be
converted into a permanent application by following these registration steps.

1) A reminder window appears each time you open an unregistered program. On the
Trial Notification Window (Figure 12), click Register via Phone.

Trial Motification CertPay? - v7.0.0.0

iBrain, Inc. has set this applicatien to run as a 15 day trial.

The program can be converted inte a permanent application at any time by contacting
iBrain, Inc. at 919-581-0505 or 800-322-4850 or email at sales@ibraininc.com for a license
code between 9:00 AM. and §:00 P.M. EST Monday through Friday.

Program and aszociated costs must be fully paid to obtain a licenze code.

You have 15 days left after today.

Once the program has been registered, it can not be
returned for credit.

‘ Register via ‘

G Regizter Later

Figure 12: Trial Notification Window

2) Click on Register via Phone and call iBrain, Inc. between 9:00 AM and 6:00 PM EST
to obtain a license code.
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Product Registration: CertPay7 - 7.0.0.0

Application Infermation:
Registration Information: -

m

iBrain, Inc.
3801 Barrett Drive
Suite 205
Raleigh, NC 27605

Product Registration Infermaticn.

Registration 314 301 866
Computer Code: 8402226
License Code:

Password:

Virite Down the Registration Code and Computer Code and Press
Cancel if vou wish to register later. Press the unlock button when you
have received a License code andior password from iBrain, Inc. via

telephone at 800-322-4650 or 915-981-0505 or email at
sales@ibraininc.com.

Cancel

Figure 13: Register via Phone

3) Information presented on the Product Licensing form (Figure 13) will be required at the
time that you call. If you are running CertPay at a time when obtaining a license code is not
possible, you are still able to perform employee updates and configuration in CertPay. Click
Cancel on the Product Licensing screen and Continue on the Trial Notification screen to
continue using CertPay.

4) To register, you will need to give us the Registration and Computer codes from the Product
Licensing Window. You will be given a license code and if necessary a password. Once
the two codes are entered, click Register Via Phone to register the application.

5) If you can not reach someone to register, a screen will appear asking for you to email us the
following information (Figure 14):

e Registration Code

e Computer Code

e Customer ID from the packing slip

e Invoice Number

Once the information above has been emailed, click Cancel and the Registration and
Computer codes will be retained for the next time the Product Registration screen.
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iBrain, Inc. (3]

& Activation has been cancelled, i you wish, you may send the

" registraticn code and computer code

to iBrain, Inc. via email to sales@ibraininc.com to receive a license
code,

Please provide your name, company name, invoice number and the
product information as shown below
when requesting a license code via email,

Preduct I: CertPay2010
Session Code: 314 301 866
Computer Code: 840 222 6

This information has been copied to the clipboard to be inserted into a
new email message,

Figure 14: Cancelled Registration

6) We will give you a license code and if necessary a password. Once the product is licensed
and employees have been updated the program will be able to write report files.

Warning: DO NOT UNINSTALL CertPay after receiving a license code
unless an iBrain, Inc. technical support engineer instructs you to do so.

H Each license code will work only once and is not transferable to other
systems.

Finished

Congratulations you have finished the installation and registration.
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IBrain, Inc. Support Policy

iBrain, Inc. warrants that this program will perform as set forth in this documentation. If the
program fails to so perform, in addition to the obligations of iBrain as set forth in the License
Agreement, iBrain will furnish telephone technical support at no cost to the licensee. In the event
performance problems result from data errors of the licensee or failure by the licensee to follow the
instructions contained herein or for any other reason except those set forth in the opening sentence
of this paragraph, iBrain will furnish telephone technical support but will charge the licensee for
telephone technical support time at iBrain’s published telephone technical support rates, which are
available upon request. Licensees are required to furnish iBrain with credit card information prior
to the beginning of any support call, which credit card information is deemed to be confidential.

The licensee may terminate the support call at will.

Feedback
If you would like to send any comments about this program to iBrain, you can contact us at

iBrain, Inc.
3901 Barrett Drive
Suite 205
Raleigh, NC 27609
Phone: (919) 981-0505 or (800) 322-4650
Fax: (919) 981-0099
e-mail: support@ibraininc.com
Web site: www.ibraininc.com
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Notes:

“Peachtree” when used herein as an entity refers to Peachtree Software, Inc., which is
the sole owner of all copyrights and trademarks to its programs referred to herein.
“Intuit” when used herein as an entity refers to Intuit, Inc., which is the sole owner of all
copyrights and trademarks to its programs referred to herein.
“Windows” when used herein refers to Microsoft Windows, a registered trademark of
Microsoft Corporation.
“iBrain” when used herein, other than as part of a program name, refers to iBrain, Inc.,
which is the sole owner of all copyrights and trademarks to its programs referred to above.
“Peachtree Accounting” or other references to Peachtree’s Windows based programs
refer to:
Peachtree Complete Accounting 2009-2011
Peachtree Premium Accounting 2009-2011
Peachtree Premium Accounting for Manufacturing 2009-2011
Peachtree Premium Accounting for Distribution 2009-2011
Peachtree Quantum 2009-2011

Acrobat ® Reader Copyright © 1987-2010 Adobe Systems Incorporated. All rights
reserved. Adobe, the Adobe logo, Acrobat, and the Acrobat logo are trademarks of Adobe
Systems Incorporated.

All “screen shots” included herein are taken either from material published by Peachtree
or from material produced by iBrain and none are relevant to any real entity.
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